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Chapter 2 
Controlling and Configuring the 
Viewports 
IN THIS CHAPTER 

Understanding 3D space 

Using the ViewCube and the SteeringWheels 

Navigating with the mouse and the Viewport Navigation Control buttons 

Changing the visual style of the viewports 

Changing viewport layouts and adding information to the viewports 

Displaying materials, lighting, and shadows 

Loading a viewport background image 

Controlling the display settings with the Viewport Setting and Preference dialog box 

Altering the viewport layout 

Displaying safe frames and setting display performance 

Defining regions and displaying statistics 

Configuring the ViewCube and SteeringWheel controls 
 

Although the Autodesk® 3ds Max® 2018 software consists of many different interface elements, such as panels, 
dialog boxes, and menus, the viewports are the main areas that will catch your attention. The four main viewports 
make up the bulk of the interface. You can think of the viewports as looking at the television screen instead of the 
remote. Learning to control and use the viewports can make a huge difference in your comfort level with 3ds Max. 
Nothing is more frustrating than not being able to rotate, pan, and zoom the view. 

The viewports have numerous settings and controls that you can use to provide thousands of different ways to look at 
your scene, and beginners can feel frustrated at not being able to control what they see. 3ds Max includes several 
handy little gizmos that make navigating the viewports much easier. This chapter includes all the details you need to 
make the viewports reveal their secrets. 

If the Viewport Navigation Controls help define what you see, the Viewport Configuration dialog box helps 
define how you see objects in the viewports. You can configure each viewport using this dialog box. To 
open this dialog box, choose the Views→Viewport Configuration menu command. You also can open this 
dialog box by right-clicking the viewport’s General label located in the upper-left corner of each viewport 
and choosing Configure from the pop-up menu.  

The viewport labels are divided into a General menu (shown as a plus sign), a point of view label, and a 
shading method label. The various pop-up menus for these labels also include many of the settings found in 
the Viewport Configuration dialog box, but the dialog box lets you alter several settings at once. You also 
can make this dialog box appear for the active viewport by right-clicking any of the Viewport Navigation 
Control buttons in the lower-right corner of the interface. 
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The Viewport Configuration dialog box contains several panels, including Visual Style & Appearance, 
Background, Layout, Safe Frames, Display Performance, Regions, Statistics, ViewCube, and 
SteeringWheels. The Preference Settings dialog box also includes many settings for controlling the behavior 
and look of the viewports. 

See Chapter 4, “Setting Preferences,” for more on the Preference Settings dialog box and all its options. 

Understanding 3D Space 
It seems silly to be talking about 3D space because we live and move in 3D space. If we stop and think about it, 3D 
space is natural to us. For example, consider trying to locate your kids at the swimming pool. If you’re standing 
poolside, the kids could be to your left or right, in front of you or behind you, or in the water below you or on the high 
dive above you. Each of these sets of directions represents a dimension in 3D space. 

Now imagine that you’re drawing a map that pinpoints a kid’s location at the swimming pool. Using the drawing 
(which is 2D), you can describe the kid’s position on the map as left, right, top, or bottom, but the descriptions of 
above and below have been lost. By moving from a 3D reference to a 2D one, the number of dimensions has 
decreased. 

The conundrum that 3D computer artists face is this: How do you represent 3D objects on a 2D device such 
as a computer screen? The answer that 3ds Max provides is to present several views, called viewports, of the 
scene. A viewport is a small window that displays the scene from one perspective. These viewports are the 
windows into the software’s 3D world. Each viewport has numerous settings and viewing options. 

Learning Axonometric versus Perspective 
When it comes to views in the 3D world, two different types exist: axonometric and perspective. 
Axonometric views are common in the CAD world, where the viewer is set at an infinite distance from the 
object such that all parallel lines remain parallel. A perspective view simulates how our eyes actually work 
and converges all points to a single location off in the distance. 

You can see the difference between these two types of views clearly if you look at a long line of objects. For 
example, if you were to look down a long row of trees lining a road, the trees would eventually merge on the 
horizon. In axonometric views, lines stay parallel as they recede into the distance. Figure 2.1 shows this 
example with the axonometric view on the left and the perspective view on the right. 



Chapter 2: Controlling and Configuring the Viewports 

31 

FIGURE 2.1 
Axonometric and perspective views 

 

Learning orthographic and isometric views 
If you dig a little deeper into axonometric views, you find two different types: orthographic and isometric. 
Orthographic views are displayed from the perspective of looking straight down an axis at an object. This 
reveals a view in only one plane. Because orthographic viewports are constrained to one plane, they show 
the actual height and width of the object, which is why the CAD world uses orthographic views extensively. 
Isometric views are not constrained to a single axis and can view the scene from any location, but all 
dimensions are still maintained. The words isometric and orthographic are often interchanged, but they refer 
to a view that has consistent dimensions. 

Discovering the viewports in 3ds Max 
Available orthographic viewports in 3ds Max include Front, Back, Top, Bottom, Left, and Right. 3ds Max 
starts up with the Top, Front, and Left orthographic viewports visible. The center label in the top-left corner 
of the viewport displays the viewport name. This label is called the Point-of-View viewport label. The 
fourth default viewport is a perspective view. Only one viewport, known as the active viewport, is enabled at 
a time. A yellow border highlights the active viewport. 

Figure 2.2 shows the viewports with a Viewpoint Datalabs model of a PT-328 U.S. torpedo boat. You can 
see the model from a different direction in each viewport. If you want to measure the boat’s length from aft 
to stern, you could get an accurate measurement using the Top or Left viewport, whereas you can use the 
Front and Left viewports to measure its precise height. Using these different viewports, you can accurately 
work with all object dimensions. 
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FIGURE 2.2 
The 3ds Max interface includes four viewports, each with a different view. 

 

Isometric views in 3ds Max are called orthographic viewports. You can create an orthographic viewport by 
rotating any of the default non-perspective views. 

Tip 
3ds Max includes several keyboard shortcuts for quickly changing the view in the active viewport, including T (Top view), B (Bottom 
view), F (Front view), L (Left view), C (Camera view), $ (Spotlight view), P (Perspective view), and U (Orthographic User view). 
Pressing the V key opens a quad menu that lets you select a new view. 

Using the Navigation Gizmos 
One of the key advantages of working in 3D is that you can view your models from an endless number of 
viewpoints, but you won’t be able to switch to these endless viewpoints until you learn to navigate the 
viewports. Being able to quickly navigate the viewports is essential to working in 3ds Max and one of the 
first skills you should master. 

To make the process of navigating within the viewports and switching among the various views easier, 3ds 
Max has some navigation gizmos that make this chore easy. These semitransparent gizmos hover in the 
upper-right corner of each viewport and provide a way to change the view without having to access a tool, 
select a menu, or even use a keyboard shortcut. 
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Working with the ViewCube 
The ViewCube consists of a 3D cube that is labeled on each side and centered in a ring aligned with the 
ground plane. Its purpose is to show the current orientation of the viewport, but it is also interactive and 
provides a way to quickly move among the different views. 

If you drag the cursor over the top of the ViewCube, shown in Figure 2.3, you’ll notice that the cube’s faces, 
corners, and edges are highlighted as the cursor moves over them. If you click when any of the cube’s parts 
are highlighted, the viewport is animated and moves to the new view so it’s positioned as if it’s pointing at 
the selected part. By slowly animating the transition to the new view, you get a better idea of the size and 
shape of the model. It also makes it easy to reorient the model if it gets twisted around to an odd angle. For 
example, if you click the cube’s face labeled Top, the view moves from its current view to the same 
orientation as the top view. 

FIGURE 2.3 
The ViewCube lets you quickly change the current view. 

 

The ViewCube also lets you click and drag on the cube to rotate the view around. The scene rotates along 
with the ViewCube. You also can click and drag on the base ring to spin the model about its current 
orientation. When you hover over the ViewCube, a small house icon appears. Clicking this icon changes the 
view to the defined home view. You can set the Home view by right-clicking the ViewCube and selecting 
the Set Current View as Home option from the pop-up menu. These same menu options also are available in 
the ViewCube menu and as an option in the General Viewport label (the small plus sign located in the 
upper-left corner of each viewport). If the ViewCube isn’t visible, you can enable it using the 
ViewCube→Show For Active View. Another option is to Show For All Views. 

Other pop-up menu options let you switch the view between orthographic and perspective views. You also 
can set the current view as Front, reset the Front view, and open the ViewCube panel that is located in the 
Viewport Configuration dialog box with the Configure option. 

The ViewCube panel in the Viewport Configuration dialog box includes settings for turning the ViewCube 
on and off In All Views in Active Layout or In Only the Active View. You also can set the ViewCube size 
and its inactive opacity. 

Tip 
If you like the ViewCube but feel that it takes up too much of the viewport, you can change its size to Small or Tiny, or you can set 
its inactive opacity to 0. When its inactive opacity is set to 0, the ViewCube isn’t visible at all until you move the cursor over its 
location, causing it to appear. 

The ViewCube panel in the Viewport Configuration dialog box also has options to control what happens 
when you click or drag the ViewCube. You can snap to the closest view when dragging the ViewCube, and 
you have options to automatically make the models fit to the view when the view changes, to use animated 
transitions, and to keep the scene upright. If you find that the view keeps ending up at odd angles when you 
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drag the ViewCube, try enabling the Keep Scene Upright option. Finally, you have an option to display the 
compass under the ViewCube and a setting for the Angle of North so you can change the compass’ 
orientation. The compass is helpful in being able to spin the model around, but if your model is something 
like a planet that doesn’t have a top or bottom, disabling the compass makes sense. 

Using the SteeringWheels 
The ViewCube is great for switching between the default views and for rotating the current view, but there 
are many additional navigation tools that aren’t covered with the ViewCube. To handle many of these other 
navigation tools, such as zooming and panning, 3ds Max includes the SteeringWheels, another gizmo for 
navigating the viewports. 

When 3ds Max is first started, the SteeringWheels are turned off, but you can enable this gizmo with the 
SteeringWheels→Toggle SteeringWheels in the General Viewport menu or by pressing the Shift+W 
shortcut. The SteeringWheels menu also is found in the General Viewport label, located in the upper-left 
corner of the viewport. Once enabled, this gizmo follows your mouse cursor around as it moves about the 
viewport, and different parts of the wheel are highlighted when you move over them. If you click and drag 
while a section of the SteeringWheels is highlighted, you can access that control. Right-clicking at any time 
will toggle the SteeringWheels off again. 

There are several different modes for the SteeringWheels in both full-size and mini versions, including the 
Full Navigation Wheel, with all commands; the View Object Wheel, with commands for navigating about 
objects; and the Tour Building Wheel, for walking through buildings. The Full Navigation Wheel, shown in 
Figure 2.4, includes the following modes: 

FIGURE 2.4 
The SteeringWheel gizmo includes several different ways to navigate the viewports. 

 

* Zoom: This causes the view to zoom in and out of the scene about the pivot. The pivot is set by holding 
down the Ctrl key while clicking. 

* Orbit: This causes the view to orbit about the pivot. The pivot is set by holding down the Ctrl key while 
clicking. 

* Pan: This causes the view to pan in the direction that you drag the cursor. 

* Rewind: As you change the scene, 3ds Max remembers each view where you stop and keeps these 
views in a buffer. The Rewind mode displays these views as small thumbnails, as shown in Figure 2.5, 
and lets you move through them by dragging the mouse. This allows you to rewind and move forward 
through the buffered views. 

Tip 
Moving between the buffered thumbnail views with the Rewind feature gradually animates the transition between adjacent 
thumbnails and allows you to click to change the view to one that is between two buffered views. 
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FIGURE 2.5 
Rewind mode lets you move back and forth through recent views. 

 

* Center: This lets you click an object to be the pivot center for zooming and orbiting. 

* Walk: This moves you forward through the scene as if you were walking through it. Holding down the 
Shift key lets you move up and down. 

* Look: This causes the camera to rotate side to side as if looking to the side. 

* Up/Down: This moves the view up and down from the current location. 

Note 
It is covered later in the chapter, but you can maximize the active viewport by clicking the Maximize Viewport Toggle button (the 
button in the lower-left corner of the interface) or by pressing Alt+W. 

In the upper-right corner of the wheel is a small X icon. This icon is used to close the SteeringWheels 
gizmo. In the lower-right corner of the wheel is a small down arrow. This icon opens a pop-up menu. Using 
the pop-up menu, you can select a different wheel type, go to the Home view as defined by the ViewCube, 
increase or decrease the walk speed, restore the original center, or open the SteeringWheels panel in the 
Viewport Configuration dialog box. These same options are also available in the SteeringWheels menu in 
the General viewport label, along with an option to Toggle the SteeringWheels on and off (Shift+W). 

Using the SteeringWheels panel in the Viewport Configuration dialog box, you can set the size and opacity 
of the SteeringWheels. Settings for controlling many of the different modes are available as well. 
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Tutorial: Navigating the active viewport 
Over time, navigating the viewports becomes second nature to you, but you need to practice to get to that 
point. In this tutorial, you get a chance to take the viewports for a spin—literally. 

To practice navigating a viewport, follow these steps: 

 1. Open the Little Dragon.max file from the Chap 02 directory in the downloaded content set. 
  This file includes a model of a cartoon dragon. It provides a reference as you navigate the viewport. 

The active viewport is the Perspective viewport. 
 2. Click the Maximize Viewport Toggle button (or press Alt+W) to make the Perspective viewport fill 

the space of all four viewports. 
 3. Click the Front face in the ViewCube to transition the view to the front view. Then move the cursor 

over the upper-right corner of the ViewCube, and click to return the view to an angled view. 
 4. Select the SteeringWheels→Toggle SteeringWheels from the General viewport menu in the upper left 

corner of the active viewport; then hold down the Ctrl key and click Bruce’s head to set the pivot. 
Then move the cursor over the Zoom button, and drag until Bruce’s head fills the viewport. 

 5. With the SteeringWheels still active, move the cursor over the Pan button, and drag the window until 
Bruce’s head is centered evenly in the viewport, as shown in Figure 2.6. Right-click in the viewport 
to toggle the SteeringWheels gizmo off. 

FIGURE 2.6 
The Perspective viewport is zoomed in on the dragon's head using the Zoom and Pan controls. 
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Controlling Viewports with a Scroll Wheel Mouse 
Now that I’ve explained the viewport navigation gizmos, I’ll explain another easy way to control the 
viewports. Often, the quickest way to control the viewports is with the mouse. To really get the benefit of 
the mouse, you need to use a mouse with a scroll wheel (which also acts as a middle mouse button). 

Rolling the scroll wheel in the active viewport zooms in to and out of the viewport by steps just like the 
bracket keys ([ and ]). You can zoom gradually by holding down the Ctrl and Alt keys while dragging the 
scroll wheel.  

Clicking and dragging the scroll wheel button pans the active viewport. Clicking and dragging with the Alt 
button held down rotates the active viewport. If the scroll wheel isn’t working, check the Viewports panel in 
the Preference Settings dialog box, found at the bottom of the Customize menu. You can select to use the 
scroll wheel control to pan and zoom in the viewports or to define and use Strokes, which is a feature for 
defining shortcuts using the mouse. 

Caution 
Be careful when zooming in with the scroll wheel. If you zoom in too far, the zooming becomes unstable. If this happens, you can 
select the Undo View Change (Shift+Z) command to undo the zoom or use the Zoom Extents button. 

Strokes are covered in Chapter 51, “Customizing the Interface.” 

Using the Viewport Navigation Controls 
Although the ViewCube, the SteeringWheels, and the scroll wheel make navigating the viewports easy, you 
can still use the standard navigation tools located in the bottom-right corner of the interface. The standard 
viewports show you several different views of your current project, but within each viewport, you can zoom 
in on certain objects, pan the view, or rotate about the center of the viewport. Clicking a viewport with any 
of the Viewport Navigation Controls automatically makes the selected viewport the active viewport. In 
Table 2.1, the keyboard shortcut for each button is listed in parentheses next to its name. 

TABLE 2.1 Viewport Navigation Controls 
Toolbar Button Name Description 

 Zoom (Alt+Z or [ or ]) Moves closer to or farther from the objects in the 
active viewport by dragging the mouse or 
zooming by steps with the bracket keys. 

 Zoom All Zooms in to or out of all the viewports 
simultaneously by dragging the mouse. 

  Zoom Extents (Ctrl+Alt+Z), Zoom 
Extents Selected (Z) 

Zooms in on all objects or just the selected 
object until it fills the active viewport. 

  Zoom Extents All (Ctrl+Shift+Z), 
Zoom Extents All Selected 

Zooms in on all objects or just the selected 
object until it fills all the viewports. 

  Field of View, Zoom Region 
(Ctrl+W) 

The Field of View button (available only in the 
perspective view) controls the width of the view. 
The Zoom Region button zooms in to the region 
selected by dragging the mouse. 

   Pan View (Ctrl+P or I), 2D Pan 
Zoom, Walk Through (Up arrow) 

Moves the view to the left, to the right, up, or 
down by dragging the mouse or by moving the 
mouse while holding down the I key. The Walk 
Through feature moves through the scene using 
the arrow keys or a mouse like a first-person 
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video game. 

   

Orbit (Ctrl+R), Orbit Selected, 
Orbit SubObject, Orbit Point of 
Interest 

Rotates the view around the global axis, 
selected object, subobject, or point of interest by 
dragging the mouse. 

 Maximize Viewport Toggle 
(Alt+W) 

Makes the active viewport fill the screen, 
replacing the four separate viewports. Clicking 
this button a second time shows all four 
viewports again. 

Caution 
When one of the Viewport Navigation buttons is selected, it is highlighted yellow. You cannot select, create, or transform objects 
while one of these buttons is highlighted. Right-clicking in the active viewpoint or clicking the Select Objects tool reverts to select 
object mode. 

Zooming a view 
You can zoom into and out of the scene in several ways. Clicking the Zoom (Alt+Z) button enters zoom 
mode, where you can zoom into and out of a viewport by dragging the mouse. This works in whichever 
viewport you drag in. To the right of the Zoom button is the Zoom All button, which does the same thing as 
the Zoom button, only to all four viewports at once. If you hold down the Ctrl key while dragging in Zoom 
mode, the zoom action happens more quickly, requiring only a small mouse movement to get a large zoom 
amount. Holding down the Alt key while dragging in Zoom mode has the opposite effect; the zoom happens 
much more slowly, and a large mouse move is required for a small zoom amount. This is helpful for fine-
tuning the zoom. 

The Zoom Extents (Ctrl+Alt+Z) button zooms the active viewport so that all objects (or the selected objects 
with the Zoom Extents Selected button) are visible in the viewport. A Zoom Extents All (Ctrl+Shift+Z) 
button is available for zooming in all viewports to all objects’ extents; the most popular zoom command 
(and the easiest to remember) is Zoom Extents Selected (Z), which is for zooming in to the extents of the 
selected objects in the active viewport. 

You can use the brackets keys to zoom in ([) and out (]) by steps. Each key press zooms in (or out) another 
step. The Zoom Region (Ctrl+W) button lets you drag over the region that you want to zoom in on. If you 
select a non-orthogonal view, such as the Perspective view, the Zoom Region button has a flyout called the 
Field of View. Using this button, you can control how wide or narrow the view is. This is like using a wide 
angle or telephoto lens on your camera. This feature is different from zoom in that the perspective is 
distorted as the Field of View is increased. 

Field of View is covered in more detail in Chapter 25, “Configuring and Aiming Cameras.” 

Panning a view 
The Viewport Navigation Controls also offer two ways to pan in a viewport. In Pan View mode (Ctrl+P), 
dragging in a viewport pans the view. Note that this doesn’t move the objects, only the view. The second 
way to pan is to hold down the I key while moving the mouse. This is known as an interactive pan. In 
addition, the Ctrl and Alt keys can be held down to speed or slow the panning motions. 

Walking through a view 
The Walk Through button (Up arrow), found as a flyout button under the Pan View button, allows you to 
move through the scene in the Perspective or Camera viewport using the arrow keys or the mouse just as you 
would if you were playing a first-person computer game. When this button is active, the cursor changes to a 
small circle with an arrow inside it that points in the direction you are moving. You need to click in the 
viewport before you can use the arrow keys. 
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Caution 
The Pan View button is a flyout only if the Perspective view or a Camera view is selected. 

The Walk Through feature includes several keystrokes for controlling the camera’s movement. The arrow 
keys move the camera forward, left, back, and right (or you can use the W, A, S, and D keys). You can 
change the speed of the motion with the Q (accelerate) and Z (decelerate) keys or with the [ (decrease step 
size) and ] (increase step size) keys. The E and C keys (or the Shift+up and Shift+down arrows) are used to 
move up and down in the scene. The Shift+spacebar key causes the camera to be set level. Dragging the 
mouse while the camera is moving changes the direction in which the camera points. 

A handy alternative to Walk Through mode is the Walkthrough Assistant, which is found on the Animation 
menu. This utility opens a dialog box that includes buttons for creating and adding a camera to a path. It also 
has controls for turning the view side to side as the camera moves along the path. 

The Walkthrough Assistant is covered in more detail in Chapter 35, “Animating with Constraints and Simple 
Controllers.” 

Rotating a view 
Rotating the view can be the most revealing of all the view changes. When the Orbit (Ctrl+R) button is 
selected, a rotation guide appears in the active viewport, as shown in Figure 2.7. This rotation guide is a 
circle with a square located at each quadrant. Clicking and dragging the left or right squares rotates the view 
side to side; the same action with the top and bottom squares rotates the view up and down. Clicking within 
the circle and dragging rotates within a single plane, and clicking and dragging outside the circle rotates the 
view about the circle’s center either clockwise or counterclockwise. If you get confused, look at the cursor, 
which changes depending on the type of rotation. The Ctrl and Alt keys also can speed and slow the rotating 
view. 

Within the Viewport Navigation Controls are several flyout options for rotating the scene. Using the Orbit 
Selection mode, you can orbit about the selected object. There are also options for orbiting about the 
selected subobject and about the cursor's location (known as the point of interest).  

Note 
The Orbit keyboard shortcut (Ctrl+R) selects whichever Orbit tool was the last to be used. 
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FIGURE 2.7 
The rotation guide appears whenever the Orbit tool is selected. 

 

Note 
If you rotate one of the default non-perspective views, it automatically becomes an orthographic view, but you can undo the change 
using the Undo View Change command in the Views Viewport menu or the Shift+Z shortcut. 

Maximizing the active viewport 
Sooner or later, the viewports will feel too small. When this happens, you have several ways to increase the 
size of your viewports. The first trick to try is to change the viewport sizes by clicking and dragging any of 
the viewport borders. Dragging on the intersection of the viewports resizes all the viewports. Figure 2.8 
shows the viewports after being dynamically resized. 

Tip 
You can return to the original layout by right-clicking any of the viewport borders and selecting Reset Layout from the pop-up 
menu. 
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FIGURE 2.8 
You can dynamically resize viewports by dragging their borders. 

 

The second trick is to use the Maximize Viewport Toggle (Alt+W) to expand the active viewport to fill the 
space reserved for all four viewports. Clicking the Maximize Viewport Toggle (or pressing Alt+W) a second 
time returns to the defined layout. 

Maximizing the viewport helps temporarily, but you can take another step before convincing your boss that 
you need a larger monitor. You can enter Expert Mode by choosing Views→Expert Mode (Ctrl+X). It 
maximizes the viewport space by removing the main toolbar, the Command Panel, and most of the lower 
interface bar. 

With most of the interface elements gone, you’ll need to rely on the menus, keyboard shortcuts, and quad 
menus to execute commands. To re-enable the default interface, click the Cancel Expert Mode button in the 
lower right of the 3ds Max window (or press Ctrl+X again). Figure 2.9 shows the interface in Expert Mode. 
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FIGURE 2.9 
Expert Mode maximizes the viewports by eliminating most of the interface elements. 

 

Controlling camera and spotlight views 
You can set any viewport to be a camera view (C) or a spotlight view ($) if a camera or a spotlight exists in 
the scene. When either of these views is active, the Viewport Navigation Control buttons change. In camera 
view, controls for dolly, roll, truck, pan, orbit, and field of view become active. A light view includes 
controls for the falloff and hotspots. 

Chapter 25, “Configuring and Aiming Cameras,” and Chapter 26, “Using Lights and Basic Lighting Techniques,” 
cover these changes in more detail. 

Setting the navigation controls to match Maya  
In many studios, you’ll find both 3ds Max and Maya. These software packages have different navigation 
controls, but you can set 3ds Max to mimic the Maya controls using the Interaction Mode panel in the 
Preference Settings dialog box. This panel includes a simple drop-down box for switching the viewport 
navigation controls between 3ds Max and Maya. If you make the change, the designated controls will be 
used automatically the next time you start up the software. 

Table 2.2 shows the basic keyboard and mouse navigation controls for both 3ds Max and Maya. 

TABLE 2.2 Viewport Navigation Controls for 3ds Max and Maya 
Viewport Navigation Control 3ds Max Maya 

Rotate View Alt+middle mouse button Alt+left mouse button 
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Pan View middle mouse button Alt+middle mouse button 

Zoom View scrub scroll wheel Alt+right mouse button 

Zoom Extents Selected Z F 

Zoom Extents All Shift+Ctrl+Z A 

Maximize Viewport Alt+W spacebar 

Undo/Redo Viewport Change Shift+Z/Shift+Y Alt+Z/Alt+Y 

Changing the Viewport Display 
Although the Viewport Navigation Controls are focused on controlling what is visible in the viewports, a 
number of useful commands are available in the Views menu and in the viewport labels at the top-left corner 
of each viewport that directly affect the viewports. The three viewport labels, shown in Figure 2.10, include 
the General viewport label (which is a simple plus sign), the Point-of-View viewport label, the Preset 
viewport label and the Shading viewport label. The last two labels show the current setting.  

Within the Views menu and the viewport labels are options to configure the viewports using the Viewport 
Configuration dialog box.  

New Feature in 2018 
The Preset viewport label is new to 3ds Max 2018. 

FIGURE 2.10 
Viewport labels in the upper-left corner of each viewport hold settings for that particular viewport. 

 

 

Undoing and saving viewport changes 
If you get lost in your view, you can undo and redo viewport changes with Undo View Change (Shift+Z) 
and Redo View Change (Shift+Y). These same commands also are available at the bottom of the Point-of-
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View viewport label. These commands are different from the Edit→Undo and Edit→Redo commands, 
which can undo or redo geometry changes. 

You can save changes made to a viewport by using the Save Active Viewport menu command in the Views 
viewport menu. This command saves the Viewport Navigation settings for recall. To restore these settings, 
use Restore Active Viewport. 

Note 
The Save and Restore Active Viewport commands do not save any viewport configuration settings, just the navigated view. Saving 
an active view uses a buffer, so it remembers only one view for each viewport. 

Disabling and refreshing viewports 
If your scene gets too complicated, you can experience some slowdown waiting for each viewport to be 
updated with changes, but fear not, because several options will come to your rescue. The first option to try 
is to disable a viewport. 

You can disable a viewport by clicking the General viewport label and selecting the Disable View menu 
command from the pop-up menu, or you can press the keyboard shortcut, D. When a disabled viewport is 
active, it is updated as normal; when it is inactive, the viewport is not updated at all until it becomes active 
again. Disabled viewports are identified by the word Disabled, which appears next to the viewport’s labels 
in the upper-left corner. 

Another trick to increase the viewport update speed is to disable the Views→Update During Spinner Drag 
menu option. Changing parameter spinners can cause a slowdown by requiring every viewport to update as 
the spinner changes. If the spinner is changing rapidly, it can really slow even a powerful system. Disabling 
this option causes the viewport to wait for the spinner to stop changing before updating. 

Sometimes when changes are made, the viewports aren’t completely refreshed. This typically happens when 
dialog boxes from other programs are moved in front of the viewports or as objects get moved around, 
because they often mask one another and lines disappear. If this happens, you can force 3ds Max to refresh 
all the viewports with the Views→Redraw All Views (keyboard shortcut, `) menu command. The Redraw 
All Views command refreshes each viewport and makes everything visible again. 

Setting the viewport visual style 
Complex scenes take longer to display and render. The renderer used for the viewports is highly optimized 
to be very quick, but if you’re working on a huge model with lots of complex textures and every viewport is 
set to display the highest-quality view, updating each viewport can slow the program to a crawl. 

By default, all the orthographic views are set to wireframe, and only the perspective view is set to show 
shading, but the Shading viewport label includes several options that let you set the visual style settings for 
the current viewport. 

Tip 
If you ever get stuck waiting for 3ds Max to complete a task, such as redrawing the viewports, you can always press the Escape 
key to suspend any task immediately and return control to the interface. 

Note 
These settings have no effect on the final rendering specified using the Rendering menu. They affect only the display in the 
viewport. 

The Rendering Level options include the following: 

* Default Shading: Shows smooth surfaces with lighting highlights 

* Facets: Shows each face as a flat surface without smoothing the edges 
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* Bounding Box: Shows a box that would enclose the object 

* Flat Color: Shows the entire object with minimal lighting 

* Clay: Shows the surface as red modeling clay, which is helpful for seeing deformations 

* Hidden Line: Shows only polygon edges facing the camera 

* Edged Faces: An option applied in addition to the shading method that shows all edge segments 

Although it really isn’t a rendering method, the Edged Faces option shows the edges for each face when a 
shaded rendering method is selected. You can enable and disable this option with the F4 keyboard shortcut. 
Figure 2.11 shows, side by side, all the various viewport rendering methods applied to a simple sphere. 

FIGURE 2.11 
The viewport rendering methods are shown from left to right. First row: Realistic, Shaded, Flat Color, Facets, 
and Hidden Line. Second row: Wireframe, Bounding Box, Clay, and Edged Faces applied to Shaded. 

 

The Realistic shading method uses any applied textures and high-quality lighting and shadows. The Shaded 
method is similar, but it uses a quick shading method called Phong shading. The Consistent Color method 
displays the entire object using a single color without any shading. The simplest rendering setting that 
represents the shape of the object is Wireframe. It gives a good representation of the object while redrawing 
very quickly. By default, the Top, Front, and Left viewports are set to Wireframe, and the Perspective 
viewport is set to Realistic. The Bounding Box method shows only the limits of the object as a rectangular 
box. 

Note 
Many material effects, such as bump and displacement maps, cannot be seen in the viewport and show up only in the final render. 

Viewing stylized scenes 
Stylized non-photorealistic effects often are not as computationally complex as realistic renderings, and as 
such, they can be enabled and displayed within the viewports as well as rendered images. Although you 
probably would not want to work in one of these stylized display modes, you can use the Shading viewport 
label to access a menu of available stylized display options. 

The options include Graphite, Color Pencil, Ink, Color Ink, Acrylic, Pastel, and Tech. Figure 2.12 shows the 
clock tower model with the Color Ink option. 
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FIGURE 2.12 
The clock tower scene is displayed using the Colored Ink display style. 

The various stylized display options also can be set in the Per-View Preferences panel in the Viewport 
Setting and Preference dialog box. 

Enhancing the Viewport 
In addition to changing the viewport display, several options allow for changing the viewport layout or 
adding information that will help during modeling and animating, such as xView, clipping view, and safe 
frames. These enhancements help the viewports be even more helpful by presenting information that you 
need. 

Changing the viewport layout 
So far, we’ve used only the default four-pane layout and the maximized viewport, but you can change the 
viewport layout to have one, two, three, or four panes orientated on top of one another or side by side. The 
easiest way to switch between the different layouts is with the Viewport Layout Tabs toolbar. 

This toolbar is opened by right-clicking any toolbar and selecting it from the pop-up menu. The toolbar 
appears by default vertically at the left edge of the viewports, as shown in Figure 2.13. Clicking the Create a 
New Viewport Layout Tab button opens a panel of several layout options. Selecting one switches the current 
layout and places the selected layout in the toolbar, where it can quickly be selected again. 
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FIGURE 2.13 
The Viewport Layout Tabs toolbar lets you quickly change between different layouts. 

For more options, including the ability to change the view type for each pane, open the Viewport 
Configuration dialog box using the Views menu, and select the Layout panel. 

Using clipping planes 
Clipping planes define an invisible barrier beyond which all objects are invisible. For example, if you have a 
scene with many detailed mountain objects in the background, working with an object in front of the scene 
can be difficult. By setting the clipping plane between the two, you can work on the front objects without 
having to redraw the mountain objects every time you update the scene. This affects only the viewport, not 
the rendered output. 

Enabling the Viewport Clipping option in the viewport Point-of-View label menu places a yellow line with 
two arrows on the right side of the viewport, as shown in Figure 2.14. The top arrow represents the back 
clipping plane, and the bottom arrow is the front clipping plane. Drag the arrows up and down to set the 
clipping planes. 
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FIGURE 2.14 
The clipping planes can be used to show the interior of this plane model. 

 

Tutorial: Viewing the interior of a tooth with clipping planes 
You can use the Viewport Clipping option in the Point-of-View viewport label to view the interior of a 
model, such as this heart model created by Viewpoint Datalabs. 

To view the interior of a heart model, follow these steps: 

 1. Open the Tooth.max file from the Chap 02 directory in the downloaded content set. 
 2. In the Point-of-View viewport label in the upper-left corner of the viewport, enable the Viewport 

Clipping option. 
  The clipping plane markers appear along the right edge of the viewport. The top marker controls the 

back clipping plane, and the bottom marker controls the front clipping plane. 

3. Drag the bottom clipping plane marker upward to slice through the tooth model to reveal its 
interior, as shown in Figure 2.15. 
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FIGURE 2.15 
By using clipping planes, you can reveal the interior of a model. 

 

Locating mesh problems with xView 
When modeling or importing mesh objects, a number of problems with the geometry can cause rendering 
artifacts such as flipped normals, overlapping faces, and open edges. Locating these problem areas can be 
tricky, requiring multiple renders to get it right. Within the viewports is a powerful analysis feature for 
locating a number of specific problem areas. This feature is called xView, and you can access it from the 
Views menu and the General viewport label. 

The xView analysis tool can locate and highlight the following anomalies: 

* Show Statistics (7): Displays the number of Polys, Tris, Edges, Verts, and Frames per Second (FPS) for 
the entire scene and for the selected object. 

* Face Orientation: Highlights the back side of the faces in the current selection to quickly identify faces 
with flipped normals. 

* Overlapping Faces: Highlights any faces that are stacked on top of each other, which can cause render 
problems. 

* Open Edges: Identifies unwanted holes in the geometry. 

* Multiple Edges: Checks for edges that are stacked on each other. Each edge should be connected to 
only two faces.  

* Isolated Vertices: Highlights vertices that aren’t connected to anything. These vertices just take up 
space. 

* Overlapping Vertices: Flags vertices that are within a given tolerance. 
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* T-Vertices: Highlights vertices where three edges meet. This can terminate an edge loop.  

* Missing UVW Coordinates: Shows any faces that have no UVW coordinates for applying textures.  

* Flipped UVW Faces: Highlights any faces that are flipped with opposite-pointing normals.  

* Overlapping UVW Faces: Displays any faces where the textures are overlapping. 

Whichever option is selected is listed at the bottom of the viewport in green, along with the number of 
offending subobjects, such as Isolated Vertices: 12 Vertices. The menu also includes options to Select the 
Results, which provides a way to quickly select and delete problem subobjects like isolated vertices. If the 
selected option has a setting such as the Tolerance of overlapping edges, you can select the Configure option 
to set this setting or click the Click Here to Configure text at the bottom of the viewport. Additional menu 
options allow you to See Through the model, Auto Update the results, and display the results at the top of 
the viewport. 

Tip 
If any xView data is displayed in the viewport, you can click it to select another data option. This lets you quickly view all the 
potential problems with the current object. 

By enabling the Show Statistics option, the selected statistics are overlaid on the active viewport, as shown 
in Figure 2.16. This is helpful for knowing how complex your model is and how many polygons it includes. 

FIGURE 2.16 
The active viewport can be set to display the selected statistics. 

 

Displaying Materials, Lighting, and Shadows in the Viewport 
The difference between what is seen in the viewport and the final render that is output is often the details 
like materials, lighting, and shadows. Over time, the viewport has gotten stronger and better at being able to 
display these details without slowing down the system, especially with the Nitrous display drivers. If you are 
working on a complex scene, you can turn down or turn off these details in order to work faster with the 
scene. 
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Viewing materials in the viewports 
The Views menu and the Preset viewport label also include several commands for making scene details such 
as materials, lighting, and shadows visible in the viewports. Each of these options can slow down the refresh 
rate, but they provide immediate feedback, which is often helpful. 

Texture maps also can take up lots of memory. The Materials →Shaded Materials with Maps command in 
the Preset viewport label shows all applied texture maps in the viewports. If you don’t need to see the 
texture maps, switching to Materials →Shaded Materials without Maps will speed up the display. The option 
to use Realistic Materials without Maps and Realistic Materials with Maps uses the video card’s memory to 
display the applied textures. 

The Materials menu also includes a toggle to Enable Transparency in the viewport. 

Tip 
The options for enabling materials in the viewports also are available as a submenu under the Preset viewport label menu. 

More on applying texture maps is covered in Chapter 18, “Adding Material Details with Maps.” 

Displaying lighting and shadows in the viewports 
Options for enabling lighting and shadow effects within the viewports are located in the Preset viewport 
label menu. By default, both shadows and ambient occlusion are enabled when the High Quality preset mode 
is selected, but you can disable them using the toggle menu options under the Lighting and Shadows menu. 
You also have an option to Illuminate the scene using Scene Lights or Default Lights. Default Lights are 
simply one or two lights added to the scene if no other lights are present to make sure the scene objects are 
visible. Figure 2.17 shows an example of viewport shadows and Ambient Occlusion. 
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FIGURE 2.17 
Viewport Shading shown with shadows enabled 

 

Ambient Occlusion is a lighting effect that adds to the realism of a scene by making objects cast shadows on 
surrounding objects based on how they block the light. Objects that are close to one another spread a soft 
shadow onto nearby objects. Figure 2.18 gives a good example. The columns in the left viewport have 
ambient occlusion turned off, but the right columns have it turned on. Notice how the columns on the right 
cast a light shadow onto the walls and onto the areas around the column caps. 
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FIGURE 2.18 
Ambient Occlusion can often be used as an alternative to full shadows. 

 

Caution 
Displaying shadows in the viewport requires Direct3D 9.0 to be installed on your system, and your video card must support Shader 
Model 2.0 or Shader Model 3.0. If your computer doesn’t support either of these Shader models, the options will be disabled in the 
viewport shading label menu and in the Viewport Configuration dialog box. You can check the capabilities of your video card using 
the Help→3ds Max Resources and Tools-->Diagnose Video Hardware command. 

To enable and configure lighting and shadows in the viewports, follow these steps: 

 1. Open the Foot bones.max file from the Chap 02 directory in the downloaded content set. 
  This file includes a set of foot bones created by Viewpoint Datalabs. An Omni light is added to the 

scene as well. 
 2. Click in the Preset viewport label, and check the Lighting and Shadows→Shadows option to make 

sure it is enabled. Then select the Per-View Presets option from the same menu to access the Per-
View Presets panel in the Viewport Setting and Preference dialog box.  

Caution 
If you don't see the Visual Style & Appearance panel in the Viewport Configuration dialog box, you probably have a different 
display driver enabled. 

 3. Enable the Ambient Occlusion setting with a Radius of 10 and an Intensity/Fade value of 1. Select the 
Point Lights/Soft-Edged Shadows option in the Lighting and Shadows Quality setting. Then click the 
OK button. 

 4. Click the Select and Move toolbar button, and drag the light object about the scene. 
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  The shadows under the foot bones are automatically updated as the light is moved, as shown in Figure 
2.19. Notice that the shadows are soft. 

FIGURE 2.19 
Lights and shadows are updated in real time when the light is moved about the scene. 

 

Working with Viewport Backgrounds 
Remember in grade school when you realized that you could immediately draw really well using tracing 
paper (where all you needed to do was follow the lines)? Well, it’s not quite tracing paper, but you can load 
background reference images into a viewport that can help as you create and position your objects. 

Changing the viewport background  
The Views→Viewport Background menu command includes submenus for switching the viewport 
background between a gradient and solid color. You also have options to display the Environment 
Background or a custom image file. These same commands also are available in the Shading viewport label. 

Tip 
Colors for the background gradient and solid color are set using the Colors panel in the Customize User Interface dialog box. You 
can open this dialog box using the Customize menu. The colors are found by selecting the Viewports option from the top drop-
down list. 

The default gradient is set to display dark gray at the top of the viewport and gradually changes to a lighter 
gray at the bottom. You can alter the displayed colors using the Colors panel in the Customize User 
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Interface dialog box opened using the Customize menu. Look for the Viewport Background, Viewport 
Gradient Background Bottom, and Viewport Gradient Background Top entries. 

Loading viewport background images 
To create a background image to be rendered along with the scene, you need to choose the Environment 
Background option and specify the background in the Environment dialog box, opened using the 
Rendering→Environment (keyboard shortcut, 8) menu command. If an environment map is already loaded 
into the Environment dialog box, you can simply click the Use Environment Background option. Keep in 
mind that the background image will not be rendered unless it is used as an Environment map. 

Environment maps are covered in Chapter 29, “Rendering a Scene and Enabling Quicksilver.” 

To load images into the viewport background, select the Custom Image File option in the Views→Viewport 
Background menu or in the Shading viewport label, and then use the Views→Viewport 
Background→Configure Viewport Background menu command (Alt+B) to open a dialog box, shown in 
Figure 2.20, in which you can select an image or animation to appear behind a viewport. Each viewport can 
have a different background image. The displayed background image is helpful for aligning objects in a 
scene, but it is for display purposes only and will not be rendered. 

FIGURE 2.20 
The Background panel in the Viewport Configuration dialog box lets you select a background source image or 
animation. 

 

The Environment Background is set using the Background color swatch and Environment Map button 
located in the Environment and Effects dialog box. You can open this panel with the 
Rendering→Environment menu or by pressing the 8 key. The benefit of using an environment background is 
that it renders with the scene objects where background images are not. 



Part I: Getting Started with Autodesk 3ds Max 2018 

56 

The Files button in the Background panel of the Viewport Configuration dialog box opens the Select 
Background Image dialog box, where you can select the image to load. Once an image is selected, its path is 
added to the Background panel of the Viewport Configuration dialog box. You can remove the designated 
file path by clicking the Remove button. The Aspect Ratio section offers options for setting the size of the 
background image. You can select to Match Viewport, Match Bitmap, or Match Rendering Output. 

The Lock Zoom/Pan option is available if either the Match Bitmap option or the Match Rendering Output 
option is selected. This option locks the background image to the geometry so that when the scene is 
zoomed or panned, the background image follows. You’ll want to make sure your scene objects are in place 
before enabling the Lock Zoom/Pan option. 

Caution 
When the Lock Zoom/Pan option is selected, the background image is resized when you zoom in on an object. Resizing the 
background image fills the virtual memory, and if you zoom in too far, the background image could exceed your virtual memory. If 
this happens, a dialog box appears to inform you of the problem and gives you the option of not displaying the background image. 

Loading viewport background animations 
The Animation Synchronization section of the Background panel lets you set which frames of a background 
animation sequence are displayed. The Use Frame and To values determine which frames of the loaded 
animation are used. The Step value trims the number of frames that are to be used by selecting every Nth 
frame. For example, a Step value of 4 would use every fourth frame. 

Tip 
Loading an animation sequence as a viewport background can really help as you begin to animate complex motions, like a running 
horse. By stepping through the frames of the animation, you can line up your model with the background image for realistic 
animations. 

The Start At value is the frame in the current scene where this background animation would first appear. The 
Sync Start to Frame value is the frame of the background animation that should appear first. The Start and 
End Processing options let you determine what appears before the Start and End frames. Options include 
displaying a blank, holding the current frame, and looping. Make sure to enable the Animate Background 
option in order to play the background animation when the animation plays. 

You can set the Apply to All Views in the Active Layout Tab or the Apply to Active View option to display 
the background in All Views or in the active viewport only. 

Tutorial: Loading reference images for modeling 
When modeling a physical object, you can get a jump on the project by taking pictures with a digital camera 
of the front, top, and left views of the object and then loading them as background images in the respective 
viewports. The background images can then be a reference for your work. This is especially helpful with 
models that need to be precise. You can even work from CAD drawings. 

To load the background images of a brass swan, follow these steps: 

 1. Choose File→New (or press Ctrl+N) to open a blank scene file. Select New All in the New Scene 
dialog box. 

 2. Right-click the Front viewport to make it the active viewport, and choose Views→Viewport 
Background→Configure Viewport Background (or press Alt+B). 

  The Background panel of the Viewport Configuration dialog box opens. 
 3. Enable the Use Files option, click the Files button, and in the Select Background Image dialog box 

that opens, select the Brass swan-front view.jpg image from the Chap 02 directory in the downloaded 
content set. Then click Open. 

 4. Select the Match Bitmap, Lock Zoom/Pan, and Apply to Active View options, and click OK to close 
the dialog box. 
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  The image now appears in the background of the Front viewport. 
 5. Repeat Steps 2 through 4 for the Top and Left viewports. 
 6. Zoom and pan each view until the image is centered in the background. 

Figure 2.21 shows the 3ds Max interface with background images loaded in the Front, Top, and Left 
viewports. 

FIGURE 2.21 
Adding a background image to a viewport can help as you begin to model objects. 

 

Setting Viewport Visual Style and Appearance 
The Viewport Setting and Preferences dialog box, shown in Figure 2.22, holds all the visual settings of the 
viewports. It also holds several presets that you can quickly select. You can access it using the 
Views→Viewport Per-View Settings menu. It is also accessible from the Shading viewport label menu. 
Using this dialog box, you can configure how the scene objects are rendered within the viewports.  

The Viewport Setting and Preferences dialog box is divided into two panels--Per-View Presets and Per-View 
Preferences. There is an option at the bottom of the dialog box that lets you apply the changes to all views. 
This lets you make changes to many viewports at once. 

New Feature in 2018 
The Viewport Setting and Preference dialog box has the same settings, but the dialog box and its location is new to 3ds Max 2018. 
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FIGURE 2.22 
The Viewport Setting and Preference dialog box sets how the scene objects are displayed. 

 

At the top of the Per-View Presets panel is a drop-down list of several presets including High-Quality, 
Standard, Performance and DX Mode. The High-Quality setting uses scene lights, shadows, ambient 
occlusion, and reflections. The Standard preset disables shadows and ambient occlusion, but keeps 
reflections enabled and uses the default lights. The Performance preset also uses default lights, but disables 
reflections and uses basic materials on all objects. The DX Mode preset uses DirectX shader materials. The 
Rendering Level setting can be set to Advanced, Basic or DX.  

New Feature in 2018 
The viewport presets are new to 3ds Max 2018. 

Using the Rendering levels 
The Preference drop-down list in the Per-View Preferences panel includes all the shading options found in 
the Shading viewport label, including all the Stylized non-photorealistic options. 

Tip 
If you ever get stuck waiting for 3ds Max to complete a task, such as redrawing the viewports, you can always press the Escape 
key to suspend any task immediately and return control to the interface. 

Note 
These settings have no effect on the final rendering specified using the Render Setup dialog box. They affect only the display in 
the viewport. 

The Rendering Level options include the following: 
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* Default Shading: Shows smooth surfaces with lighting highlights 

* Wireframe: Shows all polygon edges only 

* Clay: Displays as red modeling clay, common for deformed objects 

* Facets: Shows each face individually without any smoothing across edges 

* Bounding Box: Shows a box that would enclose the object 

* Flat Color: Shows the entire object with minimal lighting 

* Hidden Line: Shows only polygon edges facing the camera 

* Stylized: Includes artistic options such as Graphite, Color Pencil, Ink, Color Ink, Acrylic, Pastel, and 
Tech 

Figure 2.23 shows some stylized display options. 

FIGURE 2.23 
Stylized renders here include Pastel and Color Pencil along the top and Tech and Color Ink along the bottom. 

 

 

Viewing transparency 
In addition to these shading types, you also can set the viewport to display objects that contain transparency 
(which is set in the Material Editor). The Enable Transparency option is located under the viewport Preset 
label in the Materials submenu. The Transparency option is located in the Per-View Presets panel of the 
Viewport Setting and Preference dialog box. Figure 2.24 shows the transparency option disabled and 
enabled with the help of a hungry little animated creature and his ghostly rival. 
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FIGURE 2.24 
Transparency in the viewport can be enabled using the Materials menu in the Preset viewport label. 

 

Other rendering options 
The other rendering options, such as Disable View (D), Viewport Clipping, and an option to turn Textures 
on and off also are available. These options can help speed up viewport updates or increase the visual detail 
of the objects in the viewport. 

Tip 
At any time during a viewport update, you can click the mouse or press a key to cancel the redraw. 3ds Max doesn’t make you wait 
for a screen redraw to be able to execute commands with the mouse or keyboard shortcuts. 

Within the Preference section of the Per-View Preferences panel are several options that make it easier to 
see the selected object and/or subobjects. The Selection Brackets option displays white corners around the 
current selection. Selection brackets are useful for helping you see the entire size of a grouped object, but 
can be annoying if left on with many objects selected. Uncheck this option (or press the J key) to make these 
brackets disappear. The option to Display Selected with Edged Faces helps to highlight the selected object. 
If this option is enabled, the edges of the current selection are displayed regardless of whether the Edged 
Faces check box is enabled. Figure 2.25 shows the beak of a cartoon chicken selected with the Display 
Selected with Edged Faces and the Use Selection Brackets options enabled. These options make the current 
selection easy to see. 
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FIGURE 2.25 
The Display Selected with Edged Faces and Use Selection Brackets options make identifying the current 
selection easy. 

 

You use Shade Selected Faces (F2) to shade selected subobject faces in red, making them easy to see. The 
Shade Selected Objects option causes the selected object to be shaded. This is noticeable only if the render 
level is set to Wireframe or Hidden Line. It causes the selected object to be shaded. 

Note 
The Shade Selected Faces (F2) option, which shades selected subobject faces, is different from the Views→Shade Selected menu 
command, which turns on shading for the selected object in all viewports. 

Setting the Field of View 
You also can alter the Field of View (FOV) for the Perspective viewport in the Per-View Preferences panel 
of the Viewport Setting and Preference dialog box. To create a fish-eye view, decrease the FOV setting to 10 
or less. The maximum FOV value is 180, and the default value is 45. You also can change the Field of View 
using the Field of View button in the Viewport Navigation Controls. The setting in the Per-View 
Preferences panel, however, lets you enter precise values. 

See Chapter 25, “Configuring and Aiming Cameras,” for more coverage on Field of View. 

Grabbing a viewport image 
It’s not rendering, but you can grab an image of the active viewport using Tools→Preview - Grab Viewport 
→Capture Still Image. This option is also available in the Create Preview menu in the General Viewport 
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label. Before grabbing the image, a simple dialog box appears asking you to add a label to the grabbed 
image. The image is loaded into the Rendered Frame Window, and its label appears in the lower-right corner 
of the image. The Tools→Preview - Grab Viewport menu also includes options for creating, viewing, and 
renaming animated sequence files, which provides a quick way to create animation previews. 

Tip 
If you want to save the image loaded in the Rendered Frame Window, simply click the Save Image button. You also can copy, 
clone, and print from this same window. 

More on working with animation previews is covered in Chapter 34, “Understanding Animation and Keyframes.” 

 

Configuring viewport lighting and shadows 
The Per-View Presets panel of the Viewport Setting and Preference dialog box includes a number of settings 
for the viewport lighting and shadows. This panel includes options to illuminate the scene with Default 
lights (either one or two) or with Scene lights, just like the viewport Shading label menu. The one-light 
option creates a single light positioned behind the viewer and at an angle to the scene. Scenes with one light 
update more quickly than scenes with two lights. 

The Default Lights option deactivates your current scene lights and uses the default lights. This option can 
be helpful when you’re trying to view objects in a dark setting because the default lighting illuminates the 
entire scene without requiring you to remove or turn off lights. This dialog box also includes options for 
enabling Highlights, Skylight as Ambient Color, Auto Display Selected Lights and Reflections from 
Environment. 

Note 
If you are not using the Nitrous display drivers, the configuration options for lighting and shadows are different. 

The Lighting and Shadows Quality drop-down list lets you select from several different quality settings. The 
options range from Point Lights/Hard Shadows and Point Lights/Soft-Edged Shadows on the left through 
0.125X-Very Low to 16X-Very High Quality on the right. The higher quality options can take longer to 
render and use area lights to improve the quality. 

Beneath the Lighting and Shadows Quality setting is an option to have the Skylights add to the Ambient 
Color and settings for Shadows and Ambient Occlusion. You also have options to adjust the Intensity/Fade 
value for shadows and the Radius and Intensity/Fade amount of the Ambient Occlusion effect. These values 
are used to override the Viewport Shadow Intensity to dim the shadows if they are too dark. The Radius 
value sets how close objects need to be in order to be included in the ambient occlusion solution. You can 
have the environment reflections appear in the viewport as well. 

Another option available in the Visual Style & Appearance panel is the Auto Display Selected Lights. This 
option also is available in the Lighting and Shadows menu in the Preset viewport label. It is helpful when 
you’re placing and aiming lights in the scene. It causes the selected light to be displayed in the shaded 
viewport automatically. The Viewport Lighting and Shadows menu also includes options for locking and 
unlocking selected lights. 

Altering the Viewport Layout 
Now that you’ve started to figure out the viewports, you may want to change the number and size of 
viewports displayed. The easiest way to work with viewport layouts is with the Viewport Layout Tabs 
toolbar, but the Layout panel in the Viewport Configuration dialog box offers more options and lets you 
configure each viewport. 
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The Layout panel, shown in Figure 2.26, in the Viewpoint Configuration dialog box, offers several layouts 
as alternatives to the default layout (not that there is anything wrong with the default and its four equally 
sized viewports). 

FIGURE 2.26 
The Layout panel offers many layout options. 

 

 

After selecting a layout from the options at the top of the panel, you can assign each individual viewport a 
different view by clicking each viewport in the Layout panel and choosing a view from the pop-up menu. 
The view options include Perspective, Orthographic, Front, Back, Top, Bottom, Left, Right, ActiveShade, 
Track, Grid (Front, Back, Top, Bottom, Left, Right, Display Planes), Scene Explorer, Extended (Biped 
Animation WorkBench, Motion Mixer, Material Explorer, MAXScript Listener), and Shape. These view 
options are also available by clicking the viewport Point-of-View label in the upper-left corner of the 
viewport. Figure 2.27 shows a viewport layout with the Track view, Schematic view, Asset Browser, and 
Perspective views open. 
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FIGURE 2.27 
Other interfaces such as the Track View, Schematic View, and Scene Explorer can be opened within a 
viewport. 

 

Views also can be set to Cameras and Lights if they exist in the scene. Each camera and light that exists is 
listed by name at the top of the pop-up menu. 

Using Safe Frames 
Completing an animation and converting it to some broadcast medium, only to see that the whole left side of 
the animation is being cut off in the final screening, can be discouraging. If you rely on the size of the active 
viewport to show the edges of the final output, you could be way off. Using the Safe Frames feature, you 
can display some guides within the viewport that show where the content must be to avoid such problems. 

The Safe Frames panel of the Viewport Configuration dialog box lets you define several safe frame options, 
as shown in Figure 2.28, including the following: 

* Live Area: Marks the area that will be rendered, shown as yellow lines. If a background image is added 
to the viewport and the Match Rendering Output option is selected, the background image will fit within 
the Live Area. 

* Action Safe: The area ensured to be visible in the final rendered file, marked with light blue lines; 
objects outside this area will be at the edge of the monitor and could be distorted. 

* Title Safe: The area where the title can safely appear without distortion or bleeding, marked with orange 
lines. 

* User Safe: The output area defined by the user, marked with magenta lines. 
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* 12-Field Grid: Displays a grid in the viewport, marked with a pink grid. 

FIGURE 2.28 
The Safe Frames panel lets you specify areas to render. 

 

For each type of safe frame, you can set the percent reduction by entering values in the Horizontal, Vertical, 
or Both fields. The 12-Field Grid option offers 4 x 3 and 12 x 9 layout grids. 

The Show Safe Frames in Active View option displays the Safe Frame borders in the active viewport. You 
can quickly enable or disable Safe Frames by right-clicking the viewport Point-of-View label and choosing 
Show Safe Frame in the pop-up menu (or you can use the Shift+F keyboard shortcut). 

Figure 2.29 shows an elongated Perspective viewport with all the safe frame guides enabled. The Safe 
Frames show that the top and bottom of my clock tower will be cut off when rendered. 
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FIGURE 2.29 
Safe frames provide guides that help you see when the scene objects are out of bounds. 

 

Setting Display Performance 
Within the Display Performance panel, shown in Figure 2.30, are a couple of simple settings. The Improve 
Quality Progressively setting causes a rough approximation of the viewport update to be rendered 
immediately, and gradually the details are added to improve the displayed results as time progresses. This 
progressive update doesn’t slow you down but provides more detail if there is time to add it before the next 
update. 

Note 
If the Nitrous display driver is not enabled, the Adaptive Degradation panel is available in the Viewport Configuration dialog box. 

You also can set the display resolution used on procedural maps. Higher resolution values have more detail, 
and lower resolution maps render and are updated more quickly. 
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FIGURE 2.30 
The Display Performance panel offers only a few simple settings. 

 

  
You can enable Progressive Display option using the Views→Progressive Display menu command (or by 
pressing the O key). You also can turn Adaptive Degradation on and off with a button located at the bottom 
of the interface between the Prompt Bar and the Add Time Tag. The Progressive Display button looks like a 
simple cube. 

Tip 
Right-clicking the Progressive Display button opens the Display Performance panel in the Viewport Configuration dialog box. 

Defining Regions 
The Regions panel enables you to define regions and focus your rendering energies on a smaller area. 
Complex scenes can take considerable time and machine power to render. Sometimes, you want to test 
render only a portion of a viewport to check material assignment, texture map placement, or lighting. 

You can define the size of the various regions in the Regions panel of the Viewport Configuration dialog 
box, shown in Figure 2.31. 
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FIGURE 2.31 
The Regions panel enables you to work with smaller regions within your scene. 

 

After you’ve specified a Blowup Region or a Sub Region, you can select to render using these regions by 
selecting Region or Blowup from the Render Frame Window and clicking the Render button. If you click the 
Edit Region button, the specified region is displayed as an outline in the viewport. You can move this 
outline to reposition it, or drag its edge or corner handles to resize the region. The new position and 
dimension values are updated in the Regions panel for next time. Click the Render button to begin the 
rendering process. 

The difference between these two regions is that the Sub Region displays the Rendered Frame Window in 
black, except for the specified sub-region. The Blowup Region fills the entire Rendered Frame Window, as 
shown in Figure 2.32. 

You can learn more about Render Types and the Rendered Frame Window in Chapter 29, “Rendering a Scene 
and Enabling Quicksilver.” 
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FIGURE 2.32 
The image on the left was rendered using the Sub Region option; the right image used the Blowup Region. 

 

Viewing Statistics 
The Statistics panel, shown in Figure 2.33, lets you display valuable statistics in the viewport window. 
These statistics can include Polygon Count, Triangle Count, Edge Count, Vertex Count, and Frames Per 
Second. You also can select to view these statistics for all the objects in the scene (Total), for just the 
selected object, or for both. You can toggle statistics on and off for the active viewport using the 
xView→Show Statistics menu in the General viewport label or the 7 key. 

FIGURE 2.33 
The Statistics panel lets you display polygon count and frames per second in the viewport. 
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By enabling the Show Statistics in Active View option, the selected statistics are overlaid on the active 
viewport. 

Configuring the ViewCube and SteeringWheels 
The final two panels in the Viewport Configuration dialog box contain configuration settings for the 
ViewCube and SteeringWheels. The ViewCube panel includes settings for which viewports the ViewCube 
appears within, either All Views in the Active Layout or only in the Active View. You also can set the 
ViewCube’s Size and its Inactive Opacity. An Inactive Opacity value of 0 makes the ViewCube invisible 
until you move over it when it appears again. 

You also have an option for the ViewCube to snap to its closest view when dragging it. And you can define 
what happens when you click it. This provides an easy way to make the scene upright. Finally, you can 
define the compass orientation, which is the ring that surrounds the ViewCube. 

The SteeringWheels panel lets you set the size and opacity for the Big Wheels or Mini Wheels modes. 
Several other options enable tool tips, pin the wheel, and configure the individual navigation tools. 

Summary 
Viewports are the windows into the 3ds Max world. Remember that if you can’t see it, you can’t work with 
it, so you need to learn to use the viewports. You also can configure viewports to display just the way you 
desire. Most of the commands for working with the viewports are located in the Views menu and in the 
various viewport labels, but all the configuration settings are located in the Viewport Configuration dialog 
box. Using these settings, you can configure viewports to display just the way you desire. 

This chapter covered the following topics: 

* Understanding 3D space and the various viewport points-of-view 

* Navigating with the ViewCube, the SteeringWheels, and the scroll wheel 

* Using the various Viewport Navigation Control buttons 

* Changing the Visual Style of the viewport 

* Changing the viewport layout, clipping planes, and xView information 

* Turning materials, lighting, and shadows on and off in the viewport 

* Working with viewport background colors, gradients, and images 

* Changing the shading and display options in the Viewport Setting and Preference dialog box 

* Discovering the other panels of the Viewport Configuration dialog box that allow you to change the 
layout, safe frames, regions, and statistics 

* Finding out how to use Progressive Display to speed up viewport updates 

* Exploring the configuration settings for the ViewCube and SteeringWheels 

In the next chapter, you find out all the details about working with files, including loading, saving, and 
merging scene files. The next chapter also covers the import and export formats for interfacing with other 
software packages. 

 




